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Safety Information
Read these instructions carefully and look at the equipment to become familiar with
the device before trying to install, operate, service, or maintain it. The following special
messages may appear throughout this user guide or on the equipment to warn of
hazards or to call attention to information that clarifies or simplifies a procedure.

The addition of either symbol to a “Danger” or “Warning” safety
label indicates that an electrical hazard exists which will result
in personal injury if the instructions are not followed.

This is the safety alert symbol. It is used to alert you to personal
injury hazards. Obey all safety messages that follow this
symbol to avoid possible injury or death.

DANGER
DANGER indicates a hazardous situation which, if not avoided, will result in
death or serious injury.

WARNING
WARNING indicates a hazardous situation which, if not avoided, could result
in death or serious injury.

CAUTION
CAUTION indicates a hazardous situation which, if not avoided, could result
in minor or moderate injury.

NOTICE
NOTICE is used to address practices not related to physical injury.

NOTE: Provides additional information to clarify or simplify a procedure.

Please Note
Electrical equipment should be installed, operated, serviced, and maintained only by
qualified personnel. No responsibility is assumed by Schneider Electric for any
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction,
installation, and operation of electrical equipment and has received safety training to
recognize and avoid the hazards involved.

Electrical equipment should be transported, stored, installed, and operated only in the
environment for which it is designed.
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Proposition 65 Notice
WARNING: This product can expose you to chemicals including lead and lead compounds, which
are known to the State of California to cause cancer and birth defects or other reproductive harm.
For more information go to www.P65Warnings.ca.gov.
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About the Book
Document Scope

The Quick Start Guide uses an application example to describe the different steps to
quickly install, configure and use TeSys™ T.

This document is not intended to replace the following documents:
• TeSys T LTM R CANopen Motor Management Controller User Manual
• TeSys T LTM R Instruction Sheet
• TeSys T LTM E Instruction Sheet

Related Documents
Title of Documentation Reference Number

TeSys T LTM R CANopen Motor Management
Controller User Manual

1639503

TeSys T LTM R•• Instruction Sheet AAV7709901

TeSys T LTM E•• Instruction Sheet AAV7950501

TeSys T LTM CU Control Operator Unit User
Manual

1639581

TeSys T LTM CU Instruction Sheet 1639582

You can download these technical publications and other technical information from
our website at www.se.com/ww/en/download/.
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Quick Start Guide

Overview of the Application Example

Introduction
The Quick Start Guide uses an application example to illustrate each step in the
process of installing, configuring and using TeSys T.

The application example uses the LTM R controller to protect and control a motor and
its driven load, in this case, a pump.

This application example is intended to:
• show you how to configure the LTM R controller in a few steps,
• provide an example you can modify to develop your own configuration,
• serve as a starting point for the development of more complex configurations,

incorporating such additional features as HMI or network control.

Functions Performed
When the LTM R controller has been configured in order to protect and control the
motor and pump, it will perform the following functions:
• thermal overload protection
• motor temperature sensor protection
• voltage protection / undervoltage
• external ground current trip protection
• initial system configuration during commissioning using PC and PowerSuite

software

Operating Conditions
The operating conditions used in the application example are:
• motor power: 4 kW
• line-to-line voltage: 400 Vac
• current: 9 A
• control circuit voltage: 230 Vac
• 3-wire control
• motor trip class 10
• start button
• stop button
• reset button on enclosure door
• trip light
• alarm light
• full voltage, non-reversing starter (direct over the line starter)
• 24 Vdc power supply in the motor control center or control station for future use

with LTM E expansion module inputs
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Network Conditions
The network conditions for the example are:
• protocol: CANopen
• address: 1
• baud rate: 250 kbits/s

The LTM R controller is configured via PowerSuite, not via the network (configuration
via network port is disabled).

The network software setup described in this document is based on:
• Sycon network configuration software
• Unity programming software
• Premium PLC platform

Components Used
The application example uses the following components:

Item Component Description Reference Number

1 LTM R 100-240 Vac CANopen motor management controller (1.35...27 A FLC) LTMR27CFM

2 LTM E 24 Vdc expansion module LTMEV40BD

3 LTM R to LTM E RJ45 connection cable LTMCC004

4 PowerSuite cable kit VW3A8106

5 PowerSuite software on CD-ROM, version ≥ 2.5 PowerSuite

6 External ground current trip CT TA30

7 External PTC binary motor temperature sensor User supplied

Presentation of the TeSys T Motor Management System

System Overview
The TeSys T Motor Management System offers protection, control, and monitoring
capabilities for single-phase and 3-phase AC induction motors.

The system offers diagnostic and statistics functions and configurable alarms and
trips, allowing better prediction of component maintenance, and provides data to
continuously improve the entire system.

The 2 main hardware components of the system are:
• the LTM R controller, and
• the LTM E expansion module.

System Presentation
The following tables describe the main components of the TeSys T Motor
Management System.
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LTM R controller Functional Description Reference Number

• current sensing 0.4...100 A
• single-phase or 3-phase current inputs
• 6 discrete logic inputs
• 4 relay outputs: 3 SPST, 1 DPST
• connections for a ground current sensor
• connection for a motor temperature sensor
• connection for network
• connection for HMI device or expansion module
• current protection, metering and monitoring functions
• motor control functions
• power indicator
• trip and alarm LED indicators
• network communication and alarm indicators
• HMI communication LED indicator
• test and reset function

LTMR08CBD (24 Vdc, 0.4...8 A FLC)

LTMR27CBD (24 Vdc, 1.35...27 A FLC)

LTMR100CBD (24 Vdc, 5...100 A FLC)

LTMR08CFM (100...240 Vac, 0.4...8 A
FLC)

LTMR27CFM (100...240 Vac, 1.35...27
A FLC)

LTMR100CFM (100...240 Vac, 5...100 A
FLC)

LTM E Expansion Module Functional Description Reference Number

• voltage sensing 110...690 Vac
• 3-phase voltage inputs
• 4 additional discrete logic inputs
• additional voltage protection, metering and monitoring

functions
• power LED indicator
• logic input status LED indicators

Additional components required for an optional expansion module:
• LTM R controller to LTM E connection cable

LTMEV40BD (24 Vdc logic inputs)

LTMEV40FM (100...240 Vac logic inputs)

PowerSuite Software Functional Description Reference Number

• configure the system through menu entries
• display parameters, detected alarms and trips
• control the motor

Additional components required for PowerSuite software:
• a PC
• separate power source
• LTM R/LTM E to PC communication cable

PowerSuite ≥ v 2.5

VW3A8106

(PowerSuite cable kit)

LTM CU Control Operator Unit Functional Description Reference Number

• configure the system through menu entries
• display parameters, detected alarms and trips
• control the motor

Additional components required for an optional HMI device:
• LTM R/LTM E to HMI communication cable
• HMI to PC communication cable

LTM CU

VW3A1104R.0

(HMI communication cable)

VW3A8106

(PowerSuite cable kit)

LTM9KCU

Kit for portable LTM CU

LTM R and LTM E Description
The following diagrams show the features of the LTM R controller and expansion
module:
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LTM R Controller LTM E Expansion Module

1 Test / Reset button

2 HMI port with RJ45 connector connecting the LTM R controller to an HMI, PC, or
LTM E expansion module

3 Status-indicating LEDs

4 Network port with 9-pin sub-D connector connecting the LTM R controller to a
CANopen PLC

5 Plug-in terminal: control power, and internally powered logic inputs and commons

6 Plug-in terminal: double pole/single throw (DPST) output relay

7 Plug-in terminal output relay

8 Plug-in terminal: ground current trip input and temperature sensor input

9 Plug-in terminal: PLC network

1 Port with RJ45 connector to HMI or PC

2 Port with RJ45 connector to LTM R controller

3 Status-indicating LEDs

4 Plug-in terminal: voltage inputs

5 Plug-in terminal: logic inputs and common

Installation

Overview
The following procedure describes how to install and physically configure the TeSys T
system, according to the operating conditions used in the application example. The
same procedure is used for other configurations.

The full installation procedure is shown on the Instruction sheets provided with the
LTM R controller and the LTM E expansion module. It is also described in detail in the
Installation chapter of the User Manual.

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

Turn off all power supplying this equipment before working on it.

Apply appropriate personal protective equipment (PPE) and follow safe electrical
work practises.

Failure to follow these instructions will result in death or serious injury.

The following diagrams show the physical dimensions of the LTM R controller and the
LTM E expansion module:
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LTM R LTM E

Mount LTM R and LTM E
Mount the LTM R controller and the LTM E expansion module, respecting clearance
zones and operating position.
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The diagrams below show how to mount the LTM R and LTM E on a DIN rail, solid mounting plate, or Telequick plate:

This diagram shows the operating positions possible:

Connect LTM R to LTM E
Connect the LTM R controller and the LTM E expansion module using the RJ45 cable.
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Connect to a TeSys T LTM CU HMI Device (Optional)
The diagrams below show the TeSys T LTM CU HMI device connected to the LTM R
controller, with and without the LTM E expansion module:

1 LTM CU Control Operator Unit

2 RJ45 cable (VW3 A1 104R30, in this example)

3 LTM R controller

4 LTM E expansion module

Wire Current Transformers
Wire the current transformers according to the operating conditions:
• Product range → 1.35...27 A
• Nominal motor current → 9 A

1 pass through the CTwindows is sufficient in this case, although 2 passes are
possible:
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Wire Ground Current Sensor
Wire the ground current sensor:

Wire LTM R
• Wire the power supply and the I/O.
• Wire the temperature sensors.

NOTICE
RISK OF DESTROYING THE INPUTS

Connect the LTM R controller's inputs using the 3 Common (C) terminals connected
to the A1 control voltage via an internal filter.

Failure to follow these instructions can result in equipment damage.

Wire LTM E
Wire the voltage transformers and the I/O on the LTM E expansion module.
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LTM R Controller Wiring
The diagram below illustrates the main power circuit and the 3-wire (impulse) local control with network control
selectable, corresponding to the application example.

1 Contactor

2 Ground current sensor

3 PTC binary thermistor

4 Alarm indication

5 Trip indication

L Local control

O Off

N Network control

Configuration

Overview
After the wiring connections are made, the next step is to configure parameters using
PowerSuite software (see PowerSuite chapter of the User Manual).
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WARNING
UNINTENDED EQUIPMENT OPERATION

The application of this product requires expertise in the design and programming of
control systems. Only persons with such expertise should be allowed to program
and apply this product.

Follow all local and national safety codes and standards.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Install Software
Step Description

1 Place the installation disk into your PC’s CD/DVD drive.

2 Navigate to and click on the setup.exe file. The setup wizard begins.

3 Follow the instructions in the setup wizard.

Connect to PowerSuite™ Software

In the application example:

1 PC running PowerSuite software

2 PowerSuite cable kit VW3 A8 106

3 LTM R controller

4 LTM E expansion module

If you are not using the expansion module, the HMI connects directly to
the controller:

1 PC running PowerSuite software

2 PowerSuite cable kit VW3 A8 106

3 LTM R controller

Set Parameters
Step Description

1 Start up the PowerSuite software.

2 In the Load Configuration screen, select and open a configuration file with factory default settings.

3 Open the Device Information branch of the tree control and set the Operating parameter settings.

4 Open the Settings branch of the tree control.

5 Locate and set the Operating parameter settings in the Motor and Control sub-branch.

6 Repeat step 5 for all other setting item sub-branches.

7 Save a copy of the completed configuration settings to a new configuration file.

1639574EN-01 17



Motor Management Controller Quick Start Guide

List of Parameter Settings
Parameter settings for the application example:

Device Information Branch Sub-branch Parameter Setting

Device information – Current range 1.35-27 A

Network Modbus/TCP

Control voltage 100-240 Vac

Settings Branch Sub-branch Parameter Setting

Motor and Control Settings Motor operating mode Nominal voltage 400 V

Nominal power 4 kW

Operating mode 3 wire independent

Contactor rating 9 A

Phase 3 phase

Motor temperature sensor Sensor type PTC binary

Trip enable Enable

Trip level According to motor

Alarm level According to motor

Load CT Load CT ratio Internal

Load CT passes 11

Ground CT Ground CT ratio 1000:1

Control mode Local control Terminal trip

Thermal Settings Thermal overload Trip type Inverse thermal

Trip class 10

FLC1 1 50 %1 (equivalent to 9 A)

Trip enable Enable

Alarm enable Enable

Current Settings Ground current mode Trip enable Enable

Trip level 1 A

Trip timeout 0.5 s

Alarm enable Enable

Alarm level 200 mA

Voltage Settings Undervoltage Trip enable Enable

Trip level 85 %

Trip timeout 3 s

Alarm enable Enable

Alarm level 90 %

18 1639574EN-01
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Transfer the Configuration File

Step Description

1 Open the configuration file to be transferred.
• Be sure the file is in the Main window.

2 Connect your PC to the LTM R controller.
• Check the task bar to see whether your PC is connected to the LTM R controller.

3 Transfer the configuration file:
• Select PC to Device, in either the Link > File Transfer sub-menu or the icon bar.
• In the Upload Configuration dialog, click Continue. A progress bar briefly appears.
• To confirm the success of the transfer, check the results in the Output window, which opens automatically at the bottom of the

Main window.
Result: The product is now ready to use.

FLC (Full Load Current) Settings

FLC Basics
NOTE: Before setting the FLC, you must first set the Contactor rating and Load
CT ratio.

Load CT ratio = Load CT primary / (Load CTsecondary * Passes)

Current sensor max = Current range max * Load CT ratio

Current range max is determined by the LTM R controller commercial reference. It is
stored in units of 0.1 A and has one of the following values: 8.0, 27.0, or 100.0 A.

Contactor rating is stored in units of 0.1 A and is set by the user between 1.0 and
1000.0 A.

FLCmax is defined as the lower of the Current sensor max and the Contactor rating
values.

FLCmin = Current sensor max / 20 (rounded to the nearest 0.01 A.). FLCmin is stored
internally in units of 0.01 A.

NOTE: Do not set the FLC below the FLCmin.

Conversion of Amperes to FLC Settings
FLC values are stored as a percentage of FLCmax

FLC (in %) = FLC (in A) / FLCmax
NOTE: FLC values must be expressed as a percentage of FLCmax (resolution of
1 %). If you enter an unauthorized value, the LTM R will round it up to the nearest
authorized value. For example, on a 0.4-8 A unit, the step between FLCs is 0.08
A. If you try to set an FLC of 0.43 A, the LTM R will round it up to 0.4 A.

Example (No External CTs)
Data:
• FLC (in A) = 9 A
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• Current range max = 27.0 A
• Load CT primary = 1
• Load CTsecondary = 1
• Passes = 1 or 2
• Contactor rating = 18.0 A

Calculated parameters with 1 pass:
• Load CT ratio = Load CT primary / (Load CTsecondary * passes) = 1 / (1 * 1) =

1.0
• Current sensor max = Current range max * Load CT ratio = 27.0 * 1.0 = 27.0 A
• FLCmax = min (Current sensor max, Contactor rating) = min (27.0, 18.0) = 18.0 A
• FLCmin = Current sensor max / 20 = 27.0 / 20 = 1.35 A
• FLC (in %) = FLC (in A) / FLCmax = 9.0 / 18.0 = 50 %

Calculated parameters with 2 passes:
• Load CT ratio = 1 / (1 * 2) = 0.5
• Current sensor max = 27.0 * 0.5 = 13.5 A
• FLCmax = min (13.5, 18.0) = 13.5 A
• FLCmin = Current sensor max / 20 = 13.5 / 20 = 0.67 A
• FLC (in %) = FLC (in A) / FLCmax = 9.0 / 13.5 = 66 %

Diagnostic

LTM R and LTM E LEDs
As the application example uses the LTM R and LTM E, check the LEDs on both
components:

LEDs
Use the 5 LEDs on the face of the LTM R controller to monitor its state, as follows:
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LTM R LED Color Describes Indicates

HMI Comm Yellow Communication activity between LTM R controller
and expansion module

• Flashing yellow = communication
• Off = no communication

Power Green LTM R controller power or internal trip condition • Solid green = power on, no internal trips, and
motor off

• Flashing green = power on, no internal trips, and
motor on

• Off = power off, or internal trips exist.

Alarm Red Protection trip or alarm, or internal trip condition • Solid red = internal or protection trip
• Flashing red (2 x per second) = alarm
• Flashing red (5 x per second) = load shed or

rapid cycle condition
• Off = no trips, alarms, load shed or rapid cycle

(when power is On)

Fallback Red Communication connection between LTM R
controller and network module

• Solid red = in fallback
• Off = not in fallback (no power)

Status Yellow Communication activity on the network bus • Flashing yellow (0.2 s on,1.0 s off) = network
bus communication

• Off = no network bus communication

Use the 5 LEDs on the face of the LTM E expansion module to monitor its state:

LTM E LED Color Describes Indicates

Power Green or
red

Module power or internal trip
condition

• Solid green = power on with no internal trips
• Solid red = power on with internal trips
• Off = power off

Digital Inputs I.7, I.8,
I.9 and I.10

Yellow State of input • On = input activated
• Off = input not activated

Use with TeSys T LTM CU Control Operator Unit

Available Functions
Once connected to the LTM R, the LTM CU can be used to:
• configure parameters for the LTM R controller,
• display information about the LTM R controller configuration and operation,
• monitor trips and alarms generated by the controller,
• control the motor locally using the local control interface.
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LTM CU Front Face
The LTM CU front face is shown below:

1 LCD display

2 Contextual navigation keys

3 Front face RJ45 port for PC connection (covered)

4 Local control interface, including 5 control keys and 4 LEDs

Navigation Keys
The LTM CU navigation keys are contextual, that is, their function depends on the
associated icons shown on the LCD display. These icons change for different
displays, so the navigation key functions also change.

The navigation keys can be used to:
• navigate menus and sub-menus,
• scroll within a value list,
• select a setting in a value list,
• exit a value list without making a selection,
• return to the main (first-level) menu,
• switch between manual and automatic presentation mode in Quick View display.
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The diagram below shows an example of the different functions of each of the
navigation keys associated with an icon on the LCD display:

1 Information area of the LCD display

2 Contextual navigation icons area of the LCD display

3 Move up to the next higher-level menu

4 Move down to the next item in the menu

5 Select an item

6 Move up to the previous item in the menu

7 Return to the main menu

LCD Displays
The LTM CU presents 3 different LCD displays:

LCD display Functionality

Menu • Displaying and editing the configuration settings required for configuring the LTM R (metering,
protection, control and services settings)

• Displaying diagnostic and history data

Quick View • Displaying real-time metering of pre-selected parameters by automatic or manual scrolling

Detected Trips and Alarms • Displaying the most recent detected trip or alarm

Contextual Navigation Icons
The following table describes the icons used with the contextual navigation buttons on
the LTM CU:
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Icon Description Icon Description

Enables access to the main menu from a sub-menu or
from Quick View

Enables access to Quick View from the main menu or a
sub-menu

Scroll down Enables access to manual scroll mode (when Quick View
is in automatic scroll mode)

Scroll up Enables access to automatic scroll mode (when Quick
View is in manual scroll mode)

Validates a setting or value and enables access to a sub-
menu when a menu is selected

Used to increment a setting in menu mode

Move up to the next higher-level menu Used to decrement a setting in menu mode

When a menu item is password-protected, this icon
enables access to the Enter Password screen

Information Icons
The following table describes the icons provided as information in the information area
of the LCD display. They indicate, among others, the selected menu or parameter:

Icon Description Icon Description

Main menu Indicates that the present display is Quick View

Metering setting menu Indicates that a detected alarm has occurred

Protection setting menu Indicates that a detected error has occurred

Control setting menu Information

Services menu Check box selected

Language selection menu Check box unselected

Radio button selected Item has been selected (for inclusion in Quick View
display)

Radio button unselected LTM R in Configuration mode

24 1639574EN-01



Quick Start Guide Motor Management Controller

Example of an HMI Display
Here is an example of HMI LCD displaying an average current of 0.39 A in local
control, run mode:

1 Quick View display icon

2 Name of the setting currently displayed

3 Motor state

4 Short key to main menu

5 Manual scroll mode icon; pressing the associated contextual navigation key
switches to manual scroll mode

6 Value of the setting currently displayed
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Network Communication on CANopen

Wire the Communication Port
This procedure is shown on the Instruction sheets provided with the LTM R and the
LTM E, and described in the Installation chapter of the User Manual:

Set the Parameters
For the application example, set the following parameters using PowerSuite software:

Settings Branch Sub-branch Parameter Setting

Device information – Network CANopen

Communication Network port Address 1

Baud rate 250 kbits/s2

Configuration via Network port Disabled

Network Port Comm Loss parameter is enabled by default. If this is not suitable, you
can disable this parameter.

Introduction to CANopen
CANopen communication objects transmitted via the CAN network are described by
services:
• NETWORK MANAGEMENT

Starting the bus, parameter setting, monitoring.
• HIGH SPEED TRANSMISSION OF PROCESS DATA

PDOs (Process Data Objects) for real time control command.

26 1639574EN-01
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• LOW SPEED TRANSMISSION OF SERVICE DATA
SDOs (Service Data Objects)3 for configuration, setting and diagnostics.

Network Management (NMT)

(1) At power-up, the device enters the initialization state.

(2) Once initialization is finished, the pre-operational state is automatically entered (it
is possible to send parameters). Note: in the pre-operational state, you can write
some parameters selected by configuration.

(3) (6) Start_Remote_Node

(4) (7) Enter_Pre-Operational_State and apply fallback.

(5) (8) Stop_Remote_Node

(9) (10) (11) Reset_Node

(12) (13) (14) Reset_Communication

Cyclic Data Use
The real time data transfer is performed by means of Process Data Object (PDO)
telegrams. Process Data is time-critical data used to monitor and control the device.
PDO telegrams are used to exchange periodic I/O data between the PLC and the LTM
R controller.

The LMT R controller has 4 PDO sets:
• PDO1 set is predefined for control and monitoring. It is activated by default.
• PDO2 set is not predefined and is available to use. It is not activated by default.
• PDO3 set is not predefined and is available to use. It is not activated by default.
• PDO4 set is predefined to access any register (read or write) by programming

using PKW objects. It is activated by default.
◦ 4 words are reserved in Receive PDO4 to receive a request telegram.
◦ 4 words are reserved in Transmit PDO4 to provide a response telegram.
For TeSys T MMC L and TeSys T MMC LEV40, PKW use is restricted to read
access.

1639574EN-01 27
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Configure TeSys T via SyCon Software
Start configuring TeSys T via SyCon software. Example of a network configuration:

Step Action

1 Import your GSD file with File > Copy ESD.

2 Insert a master:
• click Insert > Master..., or

• select .

3 In the Insert Master window, select the TSXCPP110 master from the Available masters list.

Press the Add>> button and confirm with OK.

4 Insert a slave:
• click Insert > Slave..., or

• select .

5 In the Insert Slave window, select TeSysT from the Available slaves list.

Choose the right TeSys T variant (TeSys T MMC L EV40) and confirm with OK:
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Step Action

6 Set the bus parameter:
• Double-click the Master and select Setting > Bus setting.
• Select the Speed and confirm with OK.

7 Set the slave parameter:
• Select the name of slave: MMC_1

Save and Export the Network Configuration
Save and export the configuration for importation into the PLC configuration:

Step Action

1 Select File > Save As to open the Save as window.

2 Choose the Project path and a File name and click Save (.co file).

3 Select File > Export > ASCII to export the configuration as an ASCII file.

4 Import the CANopen configuration into the PLC configuration (PL7 or Unity Pro).

Import the Network Configuration into a PLC via Unity Software
Example of a configuration import via Unity software:
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Step Description

1 Declare the CANopen module in the Unity software:
• Right-click on slot B where the module is to be declared and add the module:

• Select TSXCPP110 in the Communication family and click OK to confirm:

2 Select the bus configuration file:
• Double-click on slot B to open the communication window.
• Click on Select Database and select your bus configuration file (.co file).

3 Check the bus configuration. Click on Bus configuration to check the CANopen devices; the number of words is the result of the
product configuration, that must correspond to:
• %MW input = 8
• %MW output = 7.

4 Configure the user options:
• Type of task (Mast or Fast) = Mast
• Bus start up = Automatic
• Number of input words = 8. Index of 1st word for I/O = 0
• Output fallback strategy (in case of processor detected failure or stop): Number of word = 7. Index of 1st word = 10.
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Step Description

5 Transfer the configuration to the PLC and run:
• Click OK to close the Check window
• Click Validate to confirm the configuration
• Load the configuration file in the PLC and run it.

6 Communication test:
• Open the debug screen to read and write cycle data.

7 Develop and load the application program, then test it.

CANopen Communication Test
The CANopen communication verification sequence is as follows:

Receive PDO1 Mapping Description
Receive PDO1 is dedicated to commanding the controller from the PLC. This default
mapping is predefined.

COB-ID Word 1 Word 2 Word 3 Word 4

0x200 + Node-ID Register 704 706 700 Empty

CANopen index 2008:5 2008:7 2008:1 –

Description Control Register Analog output 1
command

Logic output command
register

–

Transmit PDO1 Mapping Description
Transmit PDO1 is dedicated to monitoring the controller from the PLC. This default
mapping is predefined.
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COB-ID Word 1 Word 2 Word 3 Word 4

0x180 + Node-ID Register 455 456 457 458

CANopen index 2004:6 2004:7 2004:8 2004:9

Description System status
register 1

System status
register 2

Logic inputs status Logic outputs
status

Receive PDO4 Mapping Description
Receive PDO4 is dedicated to receiving PKW request telegrams.

CANopen
Index

3000:01 3000:02

Word number Word 1 Word 2 Word 3 Word 4

MSB LSB – –

Description Address register Toggle bit (bit 7) Function code
(bit 6 to 0)

0x00 Value to write: 1st
word MSW

Value to write: 2nd
word LSW

Transmit PDO4 Mapping Description
Transmit PDO4 is dedicated to providing responses to PKW request telegrams.

CANopen
Index

3000:03 3000:04

Word number Word 1 Word 2 Word 3 Word 4

MSB LSB -

Description Same as
request

Toggle bit (bit 7) Function code
(bit 6 to 0)

0x00 Read data: 1st word
MSW

Read data: 2nd
word LSW

NOTE:
• MSB = Most Significant Bit
• LSB = Least Significant Bit
• MSW = Most Significant Word
• LSW = Least Significant Word

Command Variables 700-705
Command variables 700-705 are described below:
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Register CANopen Address Variable Type Read / Write Variables

700 2008:01 Word Logic outputs command register

bit 0 Logic output 1 command

bit 1 Logic output 2 command

bit 2 Logic output 3 command

bit 3 Logic output 4 command

bit 4 Logic output 5 command

bit 5 Logic output 6 command

bit 6 Logic output 7 command

bit 7 Logic output 8 command

bits 8-15 (Reserved)

704 2008:05 Word Control register 1

bit 0 Motor run forward command

bit 1 Motor run reverse command

bit 2 (Reserved)

bit 3 Trip reset command

bit 4 (Reserved)

bit 5 Self test command

bit 6 Motor low speed command

bits 7-15 (Reserved)

705 2008:06 Word Control register 2

bit 0 Clear all command

bit 1 Clear statistics command

bit 2 Clear thermal capacity level command

bit 3 Clear controller settings command

bit 4 Clear network port settings command

bits 5-15 (Reserved)

Monitoring Variables 455-458
Monitoring variables 455, 456, 457 and 458 are described below:
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Register CANopen Address Variable Type Read-only Variables

455 2004:06 Word System status register 1

bit 0 System ready

bit 1 System on

bit 2 System trip

bit 3 System alarm

bit 4 System tripped

bit 5 Trip reset authorized

bit 6 Controller power

bit 7 Motor running (with detection of a current, if greater than 10% FLC)

bits 8-13 Motor average current ratio

32 = 100% FLC - 63 = 200% FLC

bit 14 Control via HMI

bit 15 Motor starting (start in progress)

0 = descending current is less than 150% FLC

1 = ascending current is greater than 10% FLC

456 2004:07 Word System status register 2

bit 0 Auto-reset active

bit 1 (Not significant)

bit 2 Trip power cycle requested

bit 3 Motor restart time undefined

bit 4 Rapid cycle lockout

bit 5 Load shedding

bit 6 Motor speed

bit 7 HMI port comm loss

bit 8 Network port comm loss

bit 9 Motor transition lockout

bits 10-15 (Not significant)
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Register CANopen Address Variable Type Read-only Variables

457 2004:08 Word Logic inputs status

bit 0 Logic input 1

bit 1 Logic input 2

bit 2 Logic input 3

bit 3 Logic input 4

bit 4 Logic input 5

bit 5 Logic input 6

bit 6 Logic input 7

bit 7 Logic input 8

bit 8 Logic input 9

bit 9 Logic input 10

bit 10 Logic input 11

bit 11 Logic input 12

bit 12 Logic input 13

bit 13 Logic input 14

bit 14 Logic input 15

bit 15 Logic input 16

458 2004:09 Word Logic outputs status

bit 0 Logic output 1

bit 1 Logic output 2

bit 2 Logic output 3

bit 3 Logic output 4

bit 4 Logic output 5

bit 5 Logic output 6

bit 6 Logic output 7

bit 7 Logic output 8

bits 8-15 (Reserved)
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